Context Service

- Context Service Overview, on page 1
- Task Flow to Enable Context Service, on page 8
- Context Service Setup, on page 9
- Component Configuration and Registration, on page 13
- Scripting for Context Service, on page 18

Context Service Overview

Context Service stores customer interaction data in the cloud, enabling dynamic changes that allow businesses to be flexible in how they store and use data. Often information exists across multiple applications with an ineffectual way to bring it together. Context Service enables you to get a handle on disparate data, and bridge the siloes, while creating a breadcrumb or a map of the data model. Breadcrumbs help your agents to follow a customer journey and provide relevant and immediate assistance, enhancing both the customer and the agent experience.

Context Service enables Cisco Contact Center customers to deliver a seamless omnichannel experience with out-of-the-box integration from Cisco Customer Collaboration products and APIs for third-party integration.
Context Service is a cloud functionality and, as cloud applications do, evolves rapidly. For most up-to-date information, see Cisco Context Service Help Central at https://help.webex.com/community/context-service.

**Key Functionality**

- Context Service provides a flexible data store for storing customer interaction data. Businesses can define what customer interaction data they want to store and how to store the data.

- You can use Context Service with these Cisco Contact Center products:
  - Unified Contact Center Enterprise
  - Packaged Contact Center Enterprise
  - Unified Contact Center Express
  - Hosted Collaboration Solution - Contact Center

You can use Context Center out-of-the-box and do not need to install any additional components. Context Service API integrates the front end, back end, retail, and Internet of Things applications to capture the complete customer journey.

- Context Service is compatible with both on-premises and cloud Contact Center deployments. The service provides a complete solution, not just APIs.

- Cisco hosts and manages the service, eliminating the need for businesses to deploy and manage servers.

- The service is channel-agnostic, allowing it to store interaction data from multiple customer care channels including:
  - Voice (including IVR)
  - Chat and email
• Internet of Things

• The service tags interaction data and correlates the data into a customer journey. Correlated data helps businesses to understand the history and context of their customer engagements.

• The business owns its data, although it is stored in the cloud, and the business owns and controls access to its sensitive data. Cisco partners cannot access the protected data unless the business permits it.

Business Benefits

• The service provides history and context information for all customer interactions to customer service agents. These contextual breadcrumbs allow agents to better understand the customer journey and provide better service.

• The service provides context and history that transforms traditional, isolated multichannel interactions from separate channels, into seamless omnichannel journeys. Contextual customer journeys help businesses better understand and respond to the needs of their customers.

• Out-of-the-box integration with the Cisco Contact Center portfolio adds value to existing investment.

• Open interface allows integration of new customer care channels and other business applications, Cisco, or third party, to capture a complete view of the customer journey.

Partner Benefits

Context Service offers APIs that enable Cisco partners to easily build value-add solutions using the interaction data stored in the cloud. For example, partners can build analytics applications using context data stored in the cloud.

For more information about Context Service features and usage, see Context Service Collaboration Help.

CCE Component Integration with Context Service

The following contact center components integrate with Context Service:

• **Cisco Unified CVP**—Look up customers and create and update PODs (Piece Of Data) for every voice call.

• **Cisco Enterprise Chat and Email**—Create PODs for every nonvoice Enterprise Chat and Email task.

• **Cisco SocialMiner**—Create PODs for every Task Routing task.

• **Cisco Finesse**—Agents have a gadget to view and update PODs for the tasks that they handle.

Context Service Data Model, Fields, and Fieldsets

Context Service is a flexible and secure data store in the cloud that connects the customer journey across different media channels. These media channels include voice, email, chat, mobile, and web. Information from different media channels often exists across multiple applications without an effective way to bring it together. Context Service enables you to better understand disparate data by creating a map of customer interactions. Context Service helps your agents follow the customer journey and provide relevant and immediate assistance, enhancing both the customer and the agent experience. Context Service enables Cisco Contact
Center customers to deliver a seamless omnichannel experience through an out-of-the-box integration with Cisco Customer Care products and with APIs for third-party integrations.

**Context Service Objects**

- **Customer data**—Describes who a specific customer is. For example, this includes information such as name, address, and phone number. The customer object type provides a way of linking personally identifiable information (PII) with a customer ID.

- **Activity data**—Describes a specific customer interaction. Activities are also known as PODs. Each activity reflects one step in the customer journey as the customer seeks to fulfill a request. For example, an activity occurs when a customer interacts with your organization by:
  - Browsing your organization's website.
  - Emailing your organization.
  - Calling your organization and using an IVR menu.
  - Chatting with an agent.

You can associate activities with a customer or a request.

- **Request data**—Describes what the customer wants. Requests are also used to group activities together that are related to a specific customer issue. For example:
  A customer goes online to make a credit card payment. The customer runs into an issue making the payment online, and makes a phone call instead. Attempting to make the payment online and making a phone call are two separate activities. These two activities belong to the same request, making a credit card payment.

You must associate each request with a customer.

- **Detail data**—Provides additional information on another object type. For example:
  - Notes made by an agent during an activity.
  - Feedback from the customer about an activity.

You must associate each detail with a request or an activity.
Context Service Fields and Fieldsets

Fields allow you to define the structure of the context data that is stored in Context Service objects. Fieldsets are logical grouping of fields based on your business needs. For example, you can create a shopping basket fieldset with four fields:

- Items in the cart.
- Items in a wish list.
- Total price.
- Estimated shipping costs.

You can use the Context Service fields and fieldsets to create a flexible data model. You can:

- Use the Cisco base fields and fieldsets or create your own custom fields and fieldsets.
- Add a field to multiple fieldsets.
- Associate multiple fieldsets with a single Context Service object.
- Associate the Cisco base fieldsets and your own custom fieldsets with the same Context Service object.
- Add or remove fields from a fieldset without changing any of the objects that are associated with that fieldset.

Note: Each Context Service object must have at least one fieldset assigned to it.

For example, you could use different fields for an activity for incoming calls and an activity for Mobile App shopping:

<table>
<thead>
<tr>
<th>Field Type</th>
<th>Activity for Incoming Calls</th>
<th>Activity for Mobile App Shopping</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco base fields</td>
<td>• Context_Notes&lt;br&gt;• Context_POD_Activity_Link</td>
<td>• Browsing Information&lt;br&gt;• Cart Items</td>
</tr>
<tr>
<td>Custom fields</td>
<td>• IVR Menu Selected&lt;br&gt;• Caller Authenticated</td>
<td></td>
</tr>
</tbody>
</table>

Each individual Context Service data object is limited to 256 KB.

Table 1: Context Service Object Properties

<table>
<thead>
<tr>
<th>Object Property</th>
<th>Customer</th>
<th>Request</th>
<th>Activity</th>
<th>Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>id: Unique object identifier.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
## Context Service Data Model, Fields, and Fieldsets

<table>
<thead>
<tr>
<th><strong>Object Property</strong></th>
<th><strong>Customer</strong></th>
<th><strong>Request</strong></th>
<th><strong>Activity</strong></th>
<th><strong>Detail</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>parentId</strong>: Unique identifier representing a parent Context Object.</td>
<td>N/A</td>
<td>N/A</td>
<td>✓ Optional property that links the activity with a request.</td>
<td>✓ Required property that links the detail with either a request or an activity.</td>
</tr>
<tr>
<td><strong>customerId</strong>: Unique identifier representing a customer.</td>
<td>N/A</td>
<td>✓ Required property that links the request with a customer.</td>
<td>✓ Optional property that links the activity with a customer.</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>created</strong>: Object creation time stamp.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>lastUpdated</strong>: Time stamp of when the object was last modified.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>state</strong>: Indicates if the object is active or closed. For more information, see <a href="#">Object State in the Context Service SDK Guide</a>.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>contributors</strong>: Users or Machine accounts that created or updated an object.</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
| **mediaType**: Indicates the type of media in activity. There are eight possible media types:  
  - Voice  
  - Video  
  - Chat  
  - Email  
  - Mobile  
  - Social  
  - Web  
  - Event | N/A | N/A | ✓ | N/A |
Which Data Should Be Stored in Context Service Objects?

Context Service provides a way for you to collect siloed information and creates breadcrumbs that allow you to follow a customer journey. You can design the data stored in the Context Service objects based on your business requirements and workflows. Before you decide about what data to store, consider these questions:

- Which kind of data do you need to help you solve your specific use case?
- Where is the information you need currently stored?
- Who needs access the information to solve your specific use case?

Examine the journey that your customer follows. This helps to not only answer these questions, but also to find the best way of bringing the disparate pieces of information together. For example, the customer starts online on a website and follows up with a phone call. Does your IVR or agent know about the previous website visit? Can your IVR identify a repeat caller and offer different options? Use these observations to identify application silos or organizational silos in the user journey. Identify the gaps in the information and build a Context Service data model to provide the breadcrumbs required to fill the gaps. For example, an online retail organization who wants to see if customers added items to their cart and did not buy them. The organization also wants to offer alternate suggestions based on the product customers are looking for. The object, an activity here, must have two fields. One that records the items in the customer's cart and one that lists all the products browsed. The data model design is also dynamic, that is, you can choose to add new fieldsets any time. The online retail organization decides after few months, that survey score information adds value. They can then add a survey score field to the design, without impacting existing Context data.

Context Service Data Privacy Model

Each field is defined by a data type and a security classification.

Context Service provides endpoint encryption so that sensitive data is not stored or transported in plain text. When you define a field, you specify how the field classifies data. You can classify data as:
• **Personally Identifiable Information (PII)**—Information associated with an individual who contacts your support center. PII is stored and transported in an encrypted format and requires a key to access the data. With endpoint encryption, PII can only be decrypted at the client.

• **Non-PII Encrypted**—Information that is not associated with an individual, but is considered confidential. Encrypted data is stored and transported in an encrypted format. Encrypted at endpoint, this data can only be decrypted at the client.

• **Unencrypted**—Information that is not PII and is not confidential. Unencrypted data is stored as plain text, but transported over an encrypted layer (HTTPS).

For example, name, email, and phone-number are personally identifiable. Therefore, the default fields that hold these types of data classified as PII, and are endpoint encrypted. Rewards card balances may not be PII. You can store them as Unencrypted. Non-PII Encrypted fields may be fields such as “Context Title”, the title of an activity.

---

**Note**

Context Service does not prevent you from entering PII or confidential information in unencrypted fields. Ensure that your data is stored in the appropriate field with the correct classification.

You can also define additional boundaries for your data by using lab mode and production mode. For more information, see Context Service Modes.

---

**Context Service Modes**

You can set the mode when you create the Context Service client connection or register with Context Service. The two modes are Lab and Production.

- **Lab mode**: Use this mode to test, develop, and debug Context Service. Lab mode contains nonproduction data and allows you to delete objects and flush all data. You can continue to test and develop in the Lab mode after you deploy a version to Production mode. You cannot access data created in Production mode while in Lab mode.

- **Production mode**: Use this mode when you deploy Context Service in your application. You cannot delete objects in this mode. Make sure you test Context Service using the Lab mode before you deploy the service in your application. You cannot access data created in Lab mode while in Production mode.

If multiple applications in your organization are using Context Service, make sure all the applications are using the same mode. Data created in one mode cannot be accessed in another mode.

---

**Note**

Context Service creates strict security boundaries between data created in Production and Lab modes by using separate accounts per workgroup per machine. This model enables you to isolate data between the two modes. When you register your application, both modes are enabled on the registered machine with the same connection data.

---

**Task Flow to Enable Context Service**

To enable Context Service in your contact center solution, follow this task flow:
<table>
<thead>
<tr>
<th>Sequence</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Context Service</strong></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Work with your Cisco account partner to onboard your organization: Enable Context Service for Your Organization, on page 10</td>
</tr>
<tr>
<td><strong>Configure and Register Components</strong></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Register your Unified CVP Call Servers: Register Unified CVP with Context Service, on page 13.</td>
</tr>
<tr>
<td>3</td>
<td>Configure connection data in CVP Call Studio: Configure Context Service Connection Data in Call Studio, on page 14.</td>
</tr>
<tr>
<td>4</td>
<td>Register your Cisco Finesse Servers: Register Cisco Finesse with Context Service, on page 15.</td>
</tr>
<tr>
<td>5</td>
<td>Set the principal Administration &amp; Data Server: Set the Principal AW for Context Service, on page 16.</td>
</tr>
<tr>
<td>6</td>
<td>Register Unified CCE Administration to support SocialMiner and ECE servers: Register Unified CCE Administration to Support Components, on page 16.</td>
</tr>
<tr>
<td>7</td>
<td>Enable the POD.ID expanded call variable: Enable the POD.ID Expanded Call Variable, on page 17.</td>
</tr>
<tr>
<td><strong>Create scripts</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Context Service Setup**

**Context Service Prerequisites**

Before setting up Context Service, install and configure your contact center solution and any components you are integrating with Context Service (Unified CVP, SocialMiner, Enterprise Chat and Email, and Cisco Finesse).

**Context Service Network Connectivity Requirements**

Context Service is a cloud-based service and requires that call center components using Context Service to be able to connect to the public Internet.

Context Service uses port 443 (HTTPS).

The following URLs must be whitelisted in your firewall so that your contact center components can connect to, and receive data from Context Service.
Enable Context Service for Your Organization

Context Service enables you to store and access customer interaction data in the cloud, creating a flexible and seamless omnichannel customer journey experience. To use Context Service:

- Work with your Cisco account partner to enable Context Service for your organization.
- Register Context Service for your organization to use with your contact center application.
- Connect your contact center application to Context Service.

You need Java Runtime Environment (JRE) version to 1.8.0_151 or later to use Context Service. Refer to the Compatibility Information for your specific release and update accordingly.

Create a Customer Organization and Enable Context Service

Your Cisco account partner can provide Context Service entitlement to your Cisco Webex Control Hub account.

This example shows how a partner adds a Context Service subscription to a customer organization. The example assumes that:

- The partner is a full administrator or sales administrator and can add trials.

Note

Use wildcard URLs in your allowed list because Context Service is accessed through multiple subdomains. Context Service subdomain names can dynamically change.

If you register Context Service by enabling the proxy setting option, configure the browser proxy with the URL specified in the Context Service Management Gadget. Refer to the following links to configure the proxy settings for the related browsers.

<table>
<thead>
<tr>
<th>Browser</th>
<th>URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chrome</td>
<td><a href="https://support.google.com/chrome/answer/96815?hl=en">https://support.google.com/chrome/answer/96815?hl=en</a></td>
</tr>
</tbody>
</table>

Note

Create a Customer Organization and Enable Context Service

Your Cisco account partner can provide Context Service entitlement to your Cisco Webex Control Hub account.

This example shows how a partner adds a Context Service subscription to a customer organization. The example assumes that:

- The partner is a full administrator or sales administrator and can add trials.
- The Cisco Webex Control Hub account or the organization and accounts associated with the organization have been created.

Example: Add a Trial Service

Context Service is not tied to the trial services, and does not expire when the trial period is complete.

1. Log in with your partner credentials to the Cisco Webex Control Hub.

2. Click Start Trial on the Overview page. The Start New Trial window opens.

3. Enter details about the trial:
   - **Customer Information**: Enter the name of the customer company and an email for the administrator.
   - **Trial Services**: Select the trials to add to this customer. To enable Context, select Message.
   - **Licenses Quantity**: Specify the number of licenses required for this customer trial. This number is usually the number of users who use this service. This option applies only to the Trial Services. Context Service is not bound by the number of licenses specified here.
   - **Trial duration**: Specify the duration the trial lasts before you must purchase the service. This option applies only to the Trial Services and not Context Service.
Context Service entitlement does not expire when the specified trial period ends. The organization can continue to use Context Service beyond the date of the specified Trial Duration.

You cannot change the customer name and administrator email after you create the trial. You can modify the other terms of the trial as needed.

Make sure that the email you provide is not already associated with a Cisco Webex Control Hub account.

4. Scroll down to the Non Trial Services section and select Enable Context Service for Cisco Unified Contact Center.
5. Click Next.
6. A message is displayed that asks if you want to set up the services for the customer. Click No.

You now have provided Context Service entitlement to the organization. The customer now receives a welcome email at the specified email address with the subject line Welcome to Cisco Spark Service.

The customer must click Get Started in the email and sign in to Cisco Webex Control Hub to begin their trial. The customer uses the credentials in the email to sign in and is prompted to create a password.

Your Cisco Context Service is ready. To use the service, connect to Cisco Contact Center with Context Service Enabled. See Register Context Service for more information.
Component Configuration and Registration

Register Unified CVP with Context Service

The registration process has an inactivity session timeout of 10 minutes. If the session times out, sign in again.

**Note**

For Unified CVP, Context Service is not supported for a VXML Server that is deployed in a standalone mode.

**Before you begin**

- Ensure that Unified CVP 11.6 is installed.

- Ensure that your web browser allows popups.

- If you are using Microsoft Internet Explorer, add a registry key, `TabProcGrowth`, at `HKEY_CURRENT_USER\Software\Microsoft\Internet Explorer\Main`. Set the type to `String` or `DWORD` (32-bit) and set the value to 0.

- When your organization was entitled for Cisco Context Service, you received an email requesting a sign-in and a password change. Sign in using the registration email, and change the password. Now your organization is entitled to use Context Service.

**Procedure**

**Step 1**

In the **CVP Operations Console**, choose **System > Cloud Services > Context Service** to launch the **Context Service Management** page.

**Step 2**

Provide the following information for the CVP VXML server:

- **Proxy server URL**—Specify the URL if your solution uses an optional proxy server to reach Context Service.

- **Timeout**—The amount of time, in milliseconds, that the system waits for a response from Context Service for each operation.

  See the application’s online help for the minimum, maximum, and default values for this setting for the component you are registering. Test this setting and tune it to match the latency for your solution.

- **Lab Mode**—Indicates whether Context Service is in lab mode. In lab mode, you can test, develop, and debug Context Service. Lab mode allows you to delete objects from Context Service.

**Step 3**

Click **Register**.

A popup window appears in your browser prompting you to sign in to Cisco Spark.

**Step 4**

Enter your **Cisco Webex Control Hub** admin credentials and complete the registration. (See [https://help.webex.com/docs/DOC-4165](https://help.webex.com/docs/DOC-4165) for more information.)

**Note**

Use the same organization admin account to register all components in one contact center solution.
Configure Context Service Connection Data in Call Studio

To debug a solution that uses Context Service, Call Studio requires your Context Service credentials and connection details.

**Before you begin**

Register Unified CVP with Context Service by using the Operations Console.

**Procedure**

**Step 1** From the Operations Console, select **System > Cloud Services > Context Service**.

**Step 2** Click **Connection Data**.

The system displays the credential information in the Connection Data area below the **Connection Data** button. The connection data is selected by default.

**Step 3** Copy the credentials onto the clipboard.

**Step 4** Click **OK**.

**Step 5** Launch Cisco Unified Call Studio.

**Step 6** Choose **Window > Preferences**.

**Step 7** On the **Preferences** window, choose **Call Studio > Debug Preferences**.

**Step 8** In the Context Service area enter the following connector properties:

a) In the **Connection Data** field, paste the connection data from the clipboard.

b) In the **Proxy URL** field, enter the Proxy URL in the format: `hostname:port` or `IP_address:port`.

c) In the **Timeout** field, enter how long the client waits for a response from Context Service. The allowed values are from 1200ms to 5000ms, with a default of 2400ms.

**Step 9** Click **OK**.

**Step 10** Restart VXML service and Ops Console service.

**Note** To check the validity of connection data through the Proxy URL, click **Test connection**.

**Context Service**
Register Cisco Finesse with Context Service

Before you begin

• Ensure that your web browser allows popups.

• When your organization was entitled for Cisco Context Service, you received an email requesting a sign-in and a password change. Sign in using the registration email, and change the password. Now your organization is entitled to use Context Service.

• If you wish to configure a proxy server for Context Service, configure the browser proxy with the proxy server URL you specified. Refer to your browser’s documentation for information about configuring proxy settings.

Procedure

Step 1 Register Cisco Finesse with Context Service from the Finesse administration console Context Service Management gadget.

Note Ensure to register all Finesse primary nodes.

Step 2 Provide the following information:

• **Proxy server URL**—Specify the URL if your solution uses an optional proxy server to reach Context Service.

• **Timeout**—The amount of time, in milliseconds, that the system waits for a response from Context Service for each operation.

  See the application's online help for the minimum, maximum, and default values for this setting for the component you are registering. Test this setting and tune it to match the latency for your solution.

• **Lab Mode**—Indicate whether Context Service is in lab mode. In lab mode, you can test, develop, and debug Context Service. Lab mode allows you to delete objects from Context Service.

Step 3 Click Register.

A popup window appears in your browser prompting you to sign in to Cisco Spark.

Step 4 Enter your Cisco Webex Control Hub admin credentials. Complete the registration in Cisco Webex Control Hub. (See Register Your Application with Context Service for more information.)

Note Use the same organization admin account to register all components in one contact center solution.

Cisco Webex Control Hub redirects the browser back to the application from which you initiated the registration.

What to do next

To change any of the settings after you register, edit the setting and save your change. You do not need to reregister.
After you register Cisco Finesse, agents can use the Context Service desktop gadget. It is available on the Manage Customer tab in the default agent desktop layout. If the gadget is not in your layout, you can add the gadget with the following XML:

```xml
<tab>
  <id>manageCustomer</id>
  <label>finesse.container.tabs.agent.manageCustomerLabel</label>
  <gadgets>
    <gadget>/desktop/gadgets/CustomerContext.xml</gadget>
  </gadgets>
</tab>
```

### Set the Principal AW for Context Service

Set which Administration & Data Server (AW) manages the credentials for Context Service before registering with Context Service in Unified CCE Administration.

**Procedure**

1. In Unified CCE Administration, navigate to Infrastructure > Inventory.
2. In the System Inventory, click the AW that you want to manage the Cisco Spark Control Hub admin credentials for Context Service.
3. In the Edit AW popup window, check the Principal check box.
4. Enter your solution's Diagnostic Framework credentials.
5. Click Save.

### Register Unified CCE Administration to Support Components

You register Unified CCE through the Unified CCE Administration tool. This enables SocialMiner and Enterprise Chat and Email to access Context Service in a single operation.

**Note**

Before you register with Context Service through Unified CCE Administration, upgrade the JRE on your primary AW to version 1.8.0_151 or higher. For information on upgrading JRE, see the Cisco Unified Contact Center Enterprise Installation and Upgrade Guide.

**Before you begin**

- Use the System Inventory in Unified CCE Administration to set the Principal AW before registering Unified CCE. The Principal AW manages the Context Service credentials.
- When your organization was entitled for Cisco Context Service, you received an email requesting a sign-in and a password change. Sign in using the registration email, and change the password. Now your organization is entitled to use Context Service.
Procedure

Step 1  Register from the Unified CCE Administration System > Feature > Context Service menu.

Step 2  Provide the following information:

- **Proxy server URL**—Specify the URL if your solution uses an optional proxy server to reach Context Service.

- **Timeout**—The amount of time, in milliseconds, that the system waits for a response from Context Service for each operation.

  See the application's online help for the minimum, maximum, and default values for this setting for the component you are registering. Test this setting and tune it to match the latency for your solution.

- **Lab Mode**—Indicate whether Context Service is in lab mode. In lab mode, you can test, develop, and debug Context Service. Lab mode allows you to delete objects from Context Service.

Step 3  Click Register.

Your browser displays the Cisco Spark sign-in page.

Step 4  Enter your Cisco Webex Control Hub admin credentials. Complete the registration in Cisco Webex Control Hub. (See Register Your Application with Context Service for more information.)

**Note**  Use the same organization admin account to register all components in one contact center solution.

Cisco Webex Control Hub redirects the browser back to the application from which you initiated the registration.

What to do next

Set up the ECE services in the System Console. For more information, see the Enterprise Chat and Email Deployment and Maintenance Guide (for Unified Contact Center Enterprise) at https://www.cisco.com/c/en/us/support/customer-collaboration/cisco-enterprise-chat-email/products-maintenance-guides-list.html.


If you register CCE Context Service after it is deregistered, restart the ECE Context Service Process and Instance from the ECE System Console Page. To set up ECE services in the System Console, see the Enterprise Chat and Email Deployment and Maintenance Guide (for Unified Contact Center Enterprise) at https://www.cisco.com/c/en/us/support/customer-collaboration/cisco-enterprise-chat-email/products-maintenance-guides-list.html.

Enable the POD.ID Expanded Call Variable

Enable the built-in POD.ID expanded call variable to send task context data through the system.
For a new incoming call, CVP creates a new POD and passes that POD information to CCE in `POD.ID ECC Variable`. In order for CVP to send POD.ID ECC variable to CCE, the Call Studio script must contain CVP Subdialog_Start at the beginning of the script with the business logic for creating or updating POD and must end with `CVP Subdialog_Return`. `CVP Subdialog_Return` captures the caller input and passes the POD ID to CCE Application.

**Procedure**

**Step 1**  
In the Configuration Manager, navigate to **Tools** > **List Tools**, and open the **Expanded Call Variable List**.

**Step 2**  
Click **Retrieve**.

**Step 3**  
Click the **POD.ID** expanded call variable to open that record in the **Attributes** panel.

**Step 4**  
Check the **Enabled** check box.

**Step 5**  
Click **Save**.

---

**Deregister a Component with Context Service**

After registering a server, you can deregister it if you decide to stop using Context Service with that server.

**Before you begin**

Ensure that your web browser allows popups.

**Procedure**

**Step 1**  
Launch the **Context Service Management** page for the server.

**Step 2**  
Click **Deregister**.  
Your browser displays the Cisco Spark sign-in page.

**Step 3**  
Sign in with your **Cisco Webex Control Hub** admin credentials and confirm the removal of your Hybrid Services cluster.  
You are redirected to the application page for the completion of the deregistration process. The browser window closes automatically after a successful deregistration. Avoid making any changes to the client settings until the deregistration is completed successfully.

---

**Scripting for Context Service**

The following illustration describes scripting for Context Service at a high level.
Scripting for Unified CVP with Context Service

You can create a new Call Studio application by selecting File > New > Call Studio Project from the Call Studio and adding different elements, based on your requirements. This illustration shows a sample script:
The following key explains the different context service elements:

- **Start Of Call Element**: Created, by default, with an empty project.
- **CVP Subdialog Start_01 Element**: This element defines the start of the subflow.
- **Customer_Lookup_01 Element**: This element searches for existing customer, based on phone number.
- **Validate Customer Element**: This is a decision element, which confirms customer is valid.
- **Log invalid Element**: This element returns error if customer not found.
- **Log Exception Element**: This element returns exception if any.
- **POD_Add_01 Element**: This element creates a new POD for the call using the customer id and other parameters.
- **POD_Read_01 Element**: This element reads the created POD based on POD ID.
- **POD_Update_01 Element**: This element updates the created POD with additional information.
- **Copy_of_POD_Read_01 Element**: This element reads the updated POD based on POD ID.
- **Set Value_01 Element**: This element parses the JSON data which was read and get the customer name.
- **Return_Success Element**: This subdialog return element holds the POD ID created.